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1 

Introduction

1.1 What is XWIN-PLOT?

XWIN-PLOT is a fully object-oriented, interactive and easy to use WYSIWYG1)

plot editor for creating high quality printouts of NMR data obtained with the
Bruker XWIN-NMR software package.

You will find a lot of parallels between the plot editor and other well-known draw-
ing programs and because of this it will be very easy for you to work with XWIN-
PLOT.

XWIN-PLOT is built on two basic concepts: Layouts and data set portfolios. A lay-
out describes all the attributes of graphic objects, e. g. position, size and color, but
does not contain any NMR related data. To get a relationship between such graphi-
cal objects and NMR data, a layout must be combined with a data set portfolio. A
layout, once created, can easily be reused by combining it with different portfolios.
You also may use one portfolio for several layouts to get different views of the
same data sets.

If you are still reading at this point, fine. The main problem with most software
products is that their manuals are never read. To be honest, we have to admit that

1) „What You See Is What You Get“
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we do not like spending too much time leafing through books either. On the other
hand, manuals are important because they provide a vital source of information.
Most problems that arise when using a software product can be solved by carefully
studying the software documentation.

In order to ensure that you can start using XWIN-PLOT as soon as possible, a spe-
cial Quickstart chapter has been added to this manual. So if you do not want to
wait any longer to get your first results, please take a look at that chapter.

1.2 AUTOPLOT

XWIN-PLOT provides a convenient means to create graphics interactively. Never-
theless there are situations which require layouts to be used without any user inter-
action. In these cases AUTOPLOT can control the printing. With AUTOPLOT you can
print several data sets with only one command line.

1.3 The Bruker ftp server

A convenient way for obtaining add-ons or updates to the Bruker software pack-
ages is the Bruker ftp server, ftp.bruker.de. You can connect to this server from
your local workstation or PC by issuing the following command:

ftp ftp.bruker.de

When the connection is established, you will be prompted for your login name and
your password. Use the keyword anonymous  as login name and your email
address as a password. For further information about the ftp  program consult
your ftp  manual.

1.4 The Bruker WWW server

Bruker also maintains a WWW server which can be reached via http://
www.bruker.de  using one of the several WWW clients that are available for
various computer platforms, e. g. Netscape . On this server you can find infor-
mation about the hardware and software products maintained by Bruker. You can
also download files offered by the Bruker ftp server.
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1.5 Notation

In this manual different font styles are used to represent various types of informa-
tion:

Italics are used for:

• New terms when they are defined.

Typewriter  font is used for:

• Pathnames, filenames and program names.

• Text on the screen.

Boldface is used for:

• Names of buttons, menus and menu options.

1.6 Bug reports

Did you ever find a software package that fulfilled your needs in every respect and
which also did not have any bugs? Surely not. Nevertheless experience shows that
most of the problems a user is confronted with can easily be solved by taking a
look at the manual. So please make sure that you carefully read the manual pas-
sages referring to your particular problem. If any difficulties remain, try to formu-
late the problem into a formal, detailed description before contacting us.

We really appreciate constructive criticism, so if you think you have some useful
comments concerning XWIN-PLOT, feel free to get in touch with us. If possible,
please use this email address:

nmr-software-support@bruker.de

And now we wish you success and enjoyment using Bruker‘s XWIN-PLOT plot edi-
tor.
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Starting XWIN-PLOT

Both XWIN-PLOT and AUTOPLOT are available as a stand-alone programs and as
modules which can be started from XWIN-NMR.

2.1 The XWIN-NMR module versions of XWIN-PLOT and 
AUTOPLOT

If started from within XWIN-NMR, XWIN-PLOT and AUTOPLOT automatically load
the current data set and a layout that is specified by setting the XWIN-NMR LAY-
OUT parameter. To set this layout parameter, you can use the XWIN-NMR command
edo . Click on the LAYOUT entry in the Output device parameters dialog window
and enter the layout filename for the current data set (Figure 2.1). If no layout is
specified (i.e. LAYOUT contains an empty string), XWIN-PLOT starts with a new
empty layout. AUTOPLOT cannot be started without a layout specification.

If XWIN-PLOT is started from XWIN-NMR and a layout is saved using Save As in
the File menu, the specified file name will automatically be transferred to the
LAYOUT parameter. (See chapter 5.7 on page 49.)

During start-up XWIN-PLOT first loads the default portfolio of the current user. If
there is a file portfolio.por  found in the current dataset that is loaded instead.
Finally, the content of the portfolio is transferred to the dataset list and the first
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entry is replaced with the current dataset to ensure the user initially works on the
same dataset as seen in XWIN-NMR before.

XWIN-NMR provides a familiy of three commands that can be used to start XWIN-
PLOT:

2.1.1 The command xwinplot 

Whenever you type xwinplot  command within XWIN-NMR XWIN-PLOT will
simply open the selected layout and display it exactly like you have saved it during
your last session. No automatic changes are applied. Especially the axis limits will
be those saved in the layout. 

2.1.2 Using XWIN-NMR plot limits with the xwp command

The XWIN-NMR command xwp will start XWIN-PLOT with the current layout and
set the plot limits of all data objects to those limits stored in the parameters F1P/
F2P (for 1D objects), or F1PLO/F1PHI/F2PLO/F2PHI  (for 2D objects),
respectively. If you already adapted the display in XWIN-NMR to show the region of
your interest you can simply press the defplot button to store them in the plot
parameters and type xwp to have the same region displayed in XWIN-PLOT.

The autoplot button in Xwin-nmr will create the same plot but send it directly to
the printer without any user interaction.

Figure 2.1 Choosing an XWIN-PLOT layout in XWIN-NMR
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2.1.3 Starting XWIN-PLOT with automatically calculated plot limits

When started by the XWIN-NMR command xwpr , XWIN-PLOT will apply reset
actions on all objects after loading the layout. This is similar to choosing Reset all
objects from the menu Edit. The plot limits then will be recalculated based on the
rules that are defined in the Automation dialog for each NMR object. See Chapter
7.1 on page 81 for further information about those reset actions.

This may be useful if you want to check your selected reset actions, or make use of
more complex layouts (like e.g. the 1D_H+zoom.xwp  layout).

To create this plot and send it to the printer without further interaction you can type
autoplot  in XWIN-NMR.

2.2 The stand-alone versions of XWIN-PLOT and AUTOPLOT

The stand-alone versions of XWIN-PLOT and AUTOPLOT can be started by execut-
ing the command

xwinplot [options] layout1.xwp layout2.xwp ...

or

autoplot [options] layout1.xwp layout2.xwp ...

respectively.

2.2.1 Options for the stand-alone version of XWIN-PLOT

XWIN-PLOT can be started with the following options:

-p portfolio.por Loads the portfolio file portfolio.por

-r resets all objects after start-up

If no portfolio file is specified, XWIN-PLOT will automatically load the portfolio
that was saved with Save As Default in the File menu of the Portfolio Editor dia-
log. (See chapter 5.6.2 on page 47.)
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2.2.2 Options for the stand-alone version of AUTOPLOT

2.2.2.1 Portfolio related option

If you use these options on the command line, their order is important. AUTOPLOT

evaluates all of its options from left to right.

-p portfolio.por Loads the portfolio file portfolio.por

-a portfolio.por Like -p,  but appends to the portfolio instead of overwrit-
ing its contents

-d /u/data/... Adds data set /u/data/...  to the portfolio

-r /u/data/... Removes data set /u/data/...  from the portfolio

-sa Sorts portfolio inascending order

-sd Sorts portfolio in descending order

You can combine these options in any way you like. For example you can load a
portfolio with the -l  option, then you can sort it and afterwards you can append
additional data sets to it with the -d  option.

The -d  and -r  options expect a full data set path name, e. g.

-d /u/data/guest/nmr/demospect/1/pdata/1

2.2.2.2 Other options

-s setup.prt Use printer setup file setup.prt  instead of the printer
setup that was saved with the layout (not available for
Windows NT/2000 version)

-l N Remove N data sets from the portfolio and print again

-n Don‘t reset before printing

-f Force all 1D and/or 2D objects in the layout to use axis
limits as used in XWIN-NMR (uses the F1P/F2P  parame-
ter, or F1PLO/F1PHI/F2PLO/F2PHI  parameter,
respectively)
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-o Preview instead of printing

-e output.ps Create Postscript file instead of printer output
(Windows NT/2000: PostScript (.ps) or Metafile (.emf)
format)

-v Show AUTOPLOT version number

-h Show help text

-? Same as -h

-- Explicit end of options. Use this option before specifying
a layout file that has a - as its first letter.

2.2.3 Layout file name syntax

To simplify the file name specification for layouts, it is possible to use the follow-
ing abbreviations in layout filename paths:

• ~/  can be used as an abbreviation for the home directory. If, for example, the
user guest has the home directory /usr/people/guest , the specification

~/my_layouts/layout1.xwp

is expanded to

/usr/people/guest/my_layouts/layout1.xwp

• +/  is an abbreviation for the directory $XWINNMRHOME/plot/layouts. For
example

+/layout1.xwp

could be expanded to

/u/plot/layouts/layout1.xwp



2.2.4 Dataset-related file name syntax

For objects that reference external files (NMR text objects, and the objects for
imported graphics EPSI and Meta) there also exist similar file name abbreviations:

• ~/  can be used as an abbreviation for the home directory. If, for example, the
user guest has the home directory /usr/people/guest , the specification

~/my_nmr_texts/nmrtext.txt

is expanded to

/usr/people/guest/my_nmr_texts/nmrtxt.txt

• +/  means that the referenced file is located in a dataset directory. For example

+/nmr-text.txt

is expanded to

/<DU>/data/<USER>/nmr/<EXPNO>/pdata/<PROCNO>/nmr-
text.txt

• $XWINNMRHOME is expanded to the installation path of the current XWIN-NMR

installation (e.g. /u  for SGI/Linux, or C:\Bruker\XWIN-NMR  for Windows
NT/2000 versions)
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XWIN-PLOT and XWIN-NMR

When working with XWIN-PLOT and XWIN-NMR always keep in mind that XWIN-
PLOT is a software package for displaying existing data. These data must have
been acquired or created with XWIN-NMR before it can be referred to in XWIN-
PLOT. If data is missing, the plot editor will display a warning message.

To create missing data, you can either enter the commands described below
directly in XWIN-NMR, or you can use the XWIN-NMR Interface dialog in XWIN-
PLOT. (See chapter 3.9 on page 20.) If you have entered the commands manually
in XWIN-NMR, you must use Update Data from XWIN-NMR in the XWIN-
NMR menu to transfer the changes to XWIN-PLOT.

Some data can be generated without overwriting sensible parts of the dataset (peak
lists and parameter lists). XWIN-PLOT and AUTOPLOT try to generate these files
automatically when started from within XWIN-NMR to avoid unnecessary error
messages. 

3.1 Creating a title

In XWIN-NMR the plot title can be set by the command setti . With this command
you can edit the contents of the file /<DU>/data/<USER>/nmr/<NAME>/
<EXPNO>/pdata/<PROCNO>/title 2).
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3.2 Creating a parameter listing

To create a parameter list, use the XWIN-NMR command xwp_lp . This command
will store the parameter list in /<DU>/data/<USER>/nmr/<NAME>/
<EXPNO>/pdata/<PROCNO>/parm.txt .

XWIN-PLOT and AUTOPLOT will automatically execute this command as necessary
when started from within XWIN-NMR.

3.3 Creating a peak list

Use the XWIN-NMR xwp_pp  command to create peak label information. This
command will store the peak list in the file /<DU>/data/<USER>/nmr/
<NAME>/<EXPNO>/pdata/<PROCNO>/peak.txt .

XWIN-PLOT and AUTOPLOT will automatically execute this command as necessary
when started from within XWIN-NMR.

3.4 Creating an integral range file

Integral ranges in XWIN-NMR can be determined in two ways. The command abs
starts an automatic baseline correction of the NMR spectrum and additionally
determines the regions containing spectral information. These regions are stored in
the file /<DU>/data/<USER>/nmr/<NAME>/<EXPNO>/pdata/
<PROCNO>/intrng  and can be used to calculate the integrals. The integral
ranges can also be determined manually. Click on the button integrate to switch to
the integral menu. Place the mouse inside the spectrum with the left mouse button
and select integral regions by clicking the middle mouse button. Open the File
menu and click on Save as intrng in order to store the integral ranges.

2) <DU> stands for the disk unit (e.g. u), <USER> for the user id, <NAME> for the name of the 
data set, <EXPNO> for the experiment number and <PROCNO> for the processing number.
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3.5 Creating a region file

It is possible to save the integral ranges in a special region file. This region file can
be used to determine the reset behavior of spectra (See chapter 6.1.7 on page 66.).
Simply use Save as reg instead of Save as intrng to create the region file /<DU>/
data/<USER>/nmr/<NAME>/<EXPNO>/pdata/<PROCNO>/reg .

3.6 Creating a levels file

The number of contour levels used for the display of 2D data in XWIN-NMR can be
set with the command defplot . To specify the value of each level, the command
edlev  can be used. The levels are stored in the file /<DU>/data/<USER>/
nmr/<NAME>/<EXPNO>/pdata/<PROCNO>/level . If you select a 2D data
set in XWIN-NMR and a level file does not already exist, XWIN-NMR uses the
default levels.

3.7 Creating projections

In case positive or negative projections were defined by the XWIN-NMR commands
rhpp , rhnp , rvpp  or rvnp , XWIN-PLOT will automatically add the correspond-
ing data to the Data Set Selector when started from within XWIN-NMR. Note that
XWIN-PLOT will not accept a projection that is based on a data set file that is older
than the 2D data set file.

3.8 Creating T1/T2 curve data

XWIN-PLOT can plot T1/T2 and all other relaxation type curves generated by
XWIN-NMR. The point picking for these curves and the curve calculation are done
in the T1/T2 Relaxation submenu of XWIN-NMR.

All XWIN-NMR commands which create or update the points shown on the XWIN-
NMR display3) create a file /<DU>/data/<USER>/nmr/<NAME>/<EXPNO>/
pdata/<PROCNO>/t1t2.jdx  containing these points. Only the points of one
peak are written to the t1t2.jdx  file at this time.

3) pd, pd0, pft2, prxy, lstp, nxtp, elim, rstp
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All fitting commands write out the list of fitted points, the function used for the fit
and the resulting fit parameters.

If a command which only fits the currently displayed points is used4), only these
points and the fitting results are written to the t1t2.jdx  file.

If a command which fits all points of all picked peaks is used5), all points with all
fitting results will be written to the t1t2.jdx  file.

3.9 The XWIN-NMR Interface

If XWIN-PLOT was started from XWIN-NMR, you may additionally make use of the
XWIN-NMR Interface dialog (see Figure 3.1).

With the help of this dialog, you can easily run XWIN-NMR commands on several
data sets. First select the data sets which you wish to work on. You now have the
choice of either running arbitrary commands on these data sets by entering the
commands into the text field, or of running predefined commands by using the
command buttons. These buttons include commands to edit the title, create a
parameter list, create a peak list, create integrals and to change levels.

4) ct1, ct2, simfit, simfit asc
5) dat1, dat2, simfit all, simfit asc all
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Figure 3.1 The XWIN-NMR Interface
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Quickstart guide

To get your first printouts with the XWIN-PLOT plot editor as quickly as possible,
this guide presents an example of how to create a simple layout.

4.1 Starting XWIN-PLOT from XWIN-NMR

Since the sample layout described in this quickstart guide contains a title and
parameter list, you have to use the commands setti  (to edit the title) and
xwp_pp  (to create a parameter list) in XWIN-NMR on the current data set before
starting XWIN-PLOT. (See Chapter 3.) As an alternative you can request this data
with the plot editor‘s XWIN-NMR interface after starting XWIN-PLOT.

After processing your NMR data with XWIN-NMR, you can start XWIN-PLOT by
typing xwinplot  on the XWIN-NMR command line or by clicking on the Plot-
editor menu entry in the Windows menu. When started this way, XWIN-PLOT

automatically loads the current data set. (See Chapter 5.6 for more information
about which datasets are loaded at start-up).

4.2 Setting up the printer under Unix

Before you can create your first layouts with XWIN-PLOT, you have to set up your
printer configuration. After selecting the Printer Setup entry in the Options menu,
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the dialog window shown in Figure 4.2 will be displayed. Don‘t be confused by

the variety of options available. Most of them are not important for this example.
Simply choose your printer from the Printer Type list and select the paper format
from the Paper Size list.

Figure 4.1 The Printer Setup
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The Print Command text field defines the command that will be used by XWIN-
PLOT when sending data to the printer. Your print command should look like this:

lp -c -s -oraw -n1 %s

lp  is the standard Unix print command for a System V Unix environment. The
options -c  and -oraw  as well as the %s are required. XWIN-PLOT will not print
without these options. See Chapter 5.11.3 on page 54 for more information about
the printing options.

For Linux system you should use the command

lpr %s

to use the standard Linux print system.

You can save the current settings as the default configuration with Save As
Default in the File menu. You must exit the Printer Setup dialog window with the
OK button in order for your changes to be accepted.

4.3 Setting up the printer under Windows

For your first layout you do not need to change the printer setup. XWIN-PLOT auto-
matically chooses your default printer and the paper size is set to the default format
that is selected for that printer in your system (which will be typically Letter or
A4). 

It is absolutely necessary to have at least one printer driver installed on your Win-
dows NT/2000 system to give XWIN-PLOT a chance to calculate correct page sizes.

4.4 Creating a layout

Now you are ready to draw a simple layout containing a one dimensional NMR
spectrum with an expanded region, the spectrum parameters and a title.

The first object in the layout will be the spectrum parameters. You enter the param-
eter mode by clicking on the corresponding icon (Figure 4.2). Now you can place
the rectangular area containing the parameters inside the layout window. Your lay-
out should look similar to the one in Figure 4.3 now. In case you make a mistake
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when creating or changing an object, simply click on the Undo button to reverse
an operation.

In the next step you are going to add the NMR spectrum object. Switch to the spec-
trum creation mode by clicking on the 1D spectrum icon (Figure 4.4).

Figure 4.2 The parameter mode icon

Figure 4.3 A layout containing a parameter list

Figure 4.4 The 1D spectrum mode icon
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Now you can create an object containing the one dimensional spectrum of the cur-
rent XWIN-NMR data set. Place the mouse cursor at the upper left edge of the layout
window and press the left mouse button to place the spectrum object on the draw-
ing area. As long as you keep the mouse button pressed, you can change the
objects dimensions by moving the mouse. XWIN-PLOT displays the part of the
spectrum that is visible in the XWIN-NMR processing window (See Figure 4.5).

When you are satisfied with the spectrum‘s position and size, release the mouse
button.

The next object in this example is an expanded view of a particular spectral region
which is to be added above the spectrum. Create an additional, smaller spectrum
object as already described and place it above the first. Enter the Expand mode by
clicking on the corresponding icon (Figure 4.6). Now you can define a rectangular
region inside the spectrum with the mouse. Press the left mouse button when you
are on the spectrum object and mark the region to be expanded. After releasing the
mouse button XWIN-PLOT will expand this region. This will result in a layout sim-
ilar to Figure 4.7.

Figure 4.5 Adding a spectrum to the layout
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Now it‘s time to create a title for the spectrum. To select the font type and size for
the title object, click on the Attributes button. While in the Attributes editor (Fig-
ure 5.12), you will not only be able to change the font settings, but other attributes
as well. The settings chosen in this dialog window will be valid for all the objects
created after selecting Apply or after leaving the window with OK.

Activate the title mode by clicking on the icon shown in Figure 4.8. The title object
can be placed inside the drawing area as already described for the other objects.
Figure 4.9 shows the drawing area after this operation.

Figure 4.6 The expand mode icon

Figure 4.7 The sample spectrum with an expanded region above
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In the last step you will add an annotation to the spectrum. If you want to change
the annotations font you can do this as described above in the Attributes dialog
window. Once you have adjusted the font, enter the text mode by activating the
text mode icon, visible in the Basic major editing mode (Figure 4.10). After click-

Figure 4.8 The title mode icon

Figure 4.9 A layout with spectrum, parameters and title

Figure 4.10 The text mode icon
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ing at the desired location on the layout window, you can enter a text, such like
„Annotation“ in this example. The final text position can be set by pressing the left
mouse button. For our example we will place the text near one of the prominent
peaks in the lower spectrum. This will result in a layout similar to the one shown in
Figure 4.11.

The annotation may be a reference to one of the spectrum‘s peaks. You can empha-
size fact by drawing an arrow from the annotation to the peak on the left. Before
you draw an arrow, go to the Layout Setup (Figure 4.12) and select the „Snap-In“
mode None, which allows objects to be positioned at arbitrary points. To create an
arrow object, you go into the Basic editing mode and to enter the line mode by
selecting the corresponding icon (Figure 4.13). Now draw a line with the mouse,
starting near the annotation and ending near the peak. The line‘s starting point is
set by pressing the left mouse button. Releasing the mouse button marks the end of
the line.

Finally, add an arrow tip to the end of the line. After entering one of the marking
modes (Figure 4.14) you can mark the line object by clicking on it with the left
mouse button. To edit the object select the Edit command button. The line objects

Figure 4.11 Placing an annotation above the spectrum
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edit dialog window will pop up as shown in Figure 4.15. In this editor you can
select various line attributes and you can convert a line into an arrow by selecting
the corresponding buttons. The arrow tips width can be changed with a slider.

After accepting your changes with OK or Apply the sample layout is complete. It
should look similar to the layout in Figure 4.16.

Figure 4.12 The Layout Setup

Figure 4.13 The line creation mode icon

Figure 4.14 The marking mode icons
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Figure 4.15 The line object editor

Figure 4.16 The final sample layout
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4.5 Printing the layout

To print your layout, choose the Print option in the File menu. Printing will com-
mence after clicking on the Print button in the Print dialog window (Figure 4.17).

Depending on your printer it will take a while for a document to print, so be
patient. You can continue to work with XWIN-PLOT or XWIN-NMR while printing is
in progress.

4.6 Saving the layout

If you want to save the layout for use with other data sets later on, choose Save As
in the File menu. A file selector will appear where you can enter the name of your
layout6). In case XWIN-PLOT was started from within XWIN-NMR, information
about the layouts filename will be saved in the current data set parameters.

Figure 4.17 The Print dialog window

6) By convention XWIN-PLOT layout filenames have the extension .xwp .
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5 

The layout window

A key concept of XWIN-PLOT are its layouts. After starting the plot editor, an
empty layout window will be displayed.

5.1 The structure of a layout window

XWIN-PLOT can maintain a virtually unlimited number of layout windows. Each
layout window may contain simple graphic objects like lines or rectangles as well
as complex NMR related objects like FIDs and NMR spectra. Most of the interac-
tion between the user and the plot editor is mouse based and takes place within the
layout windows. Additional layout windows can be opened by selecting New in
the File menu or, if the layout to be used is already available on disk, with the
Open command.

A layout window consists of five main areas. (See Figure 5.1.) At the top of each
window a menu bar is displayed. Most entries in the menu can be reached using
keyboard shortcuts.

Below the menu there is a button bar with some frequently used commands. With
the icons located on the left side of the window, the user can choose the plot editors
drawing mode. The active mode is displayed in the Mode field at the top left-hand
side of the window and can be changed by clicking on one of the drawing mode
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icons. There are two major editing modes: Basic mode for drawing simple, not
NMR-related objects, and NMR mode.

The main part of the layout window consists of the layout area which represents a
sheet of paper including its borders. An object that is on or outside the border lines
will not be printed.7). The paper size and format can be defined in the Printer
Setup dialog. (See “Printing a layout” on page 50.) By moving the scroll areas at
the right and bottom of the graphics area the visible part of the drawing area can be
moved. Scrollbars are only present if the size of the current graphics area exceeds
the size of the visible drawing area.

Figure 5.1 An empty layout window

7) If a graphics object is placed on the border it will be clipped when it is printed.

Status line

Command buttons

Current input mode

Cursor

Major editing modes

Minor editing modes

Selection modes
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5.2 Input Modes

5.2.1 Creation modes

The object types that can be created by XWIN-PLOT include simple objects like
lines or rectangles in Basic editing mode as well as complex NMR related objects
in NMR editing mode, e. g. FIDs or spectra. An object is drawn by first choosing
the editing mode and then selecting the corresponding drawing mode. This mode is
selected by clicking on one of the icons at the left edge of the graphics window.
The current drawing mode is indicated by the icon inside the Mode field at the
lower left. (Figure 5.2) A new object is placed on the screen by pressing the left

mouse button and simultaneously moving the mouse pointer. If an object is defined
by several points, e. g. a polyline or a bezier curve, the last point is set with the
middle mouse button.

The graphic attributes (e.g. color, line and fill style, font type) of new objects is
taken from the Attributes Selector (see Chapter 5.5 on page 44). For new objects
that require an NMR data set, the data set is taken from the Data Set Selector (see
Chapter 5.6 on page 46).

5.2.1.1 Basic objects

XWIN-PLOT supports the following basic graphical object types which are accessi-
ble in the Basic major editing mode:

• Lines

• Polylines

• Polygons

• Rectangles

Figure 5.2 The mode field reflects the current drawing mode



38 5.2 Input Modes

DONE

INDEX

INDEX

• Circles

• Open and closed bezier curves

• Standard text objects

• EPSI8) objects (Unix version) / Metafile objects (Windows version)

For each of these objects there is a corresponding drawing mode which can be
selected by clicking on one of the drawing mode icons shown in Figure 5.3. The

editing of basic objects will be described in detail later. (Refer to page 59 in Chap-
ter .)

5.2.1.2 NMR objects

The following NMR objects are supported by XWIN-PLOT when the NMR major
editing mode is selected:

• Spectral parameters

• Spectra titles

• FIDs

• 1D spectra

8) Encapsulated PostScript Interchange

Figure 5.3 The icons for creating basic objects
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• Stacked 1D spectra

• 2D spectra

• T1/T2 curves

• NMR dataset-related text objects

The NMR objects are handled the same way as the basic objects.

For each object there is a corresponding drawing mode which is activated by
selecting one of the icons on the left side of the graphics window. The editing of

NMR related objects will be described in detail in Chapter .

5.2.2 Expand and zoom mode

With the expand and zoom modes (Figure 5.5) a part of the layout or of an individ-
ual object can be enlarged. Expansion applies to the individual objects of a layout. 

While the expansion of objects only applies to NMR objects like FIDs and spectra,
zooming affects the layout as a whole.

Figure 5.4 The icons for creating NMR related objects

Figure 5.5 The icons for expanding and zooming
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After entering the zoom mode you can mark the area to be zoomed by moving the
mouse while the left mouse button is being pressed. The area on which the zoom-
ing will have an effect is indicated by a rectangle. After releasing the mouse but-
ton, XWIN-PLOT will display an enlarged view of this area.

The buttons Zoom In and Zoom Out in the upper part of the layout window (Fig-
ure 5.6) can be used to zoom the currently visible region. Click on Full if you want

the whole layout to be displayed.

The expand operation is similar to zooming but only applies to a single object. In
expand mode the part of an object that was marked with the mouse is enlarged and
replaces the original object. When expanding an object with the Shift modifier key
pressed, the objects height remains unchanged. If the Control modifier key is
pressed, the width is not changed. Pressing the Alt modifier key will „blow-up“ a
portion of the spectrum according to the settings in the Global Setup dialog (See
chapter 5.11.1 on page 52.). Figure 5.7 shows an example.

5.3 Working with objects

5.3.1 Moving objects

An object can be moved any time, i. e. independent from the input mode. To move
an object, place the cursor within the object‘s bounding box, keep the middle
mouse button pressed and move the mouse. The bounding box is indicated by a
dotted rectangle as soon as the cursor enters the box. It is not necessary to mark an
object in order to move it.

5.3.2 Marking objects

Within XWIN-PLOT there are two different modes for marking objects. Objects can
be selected either by their individual points (Figure 5.9) or as a whole (Figure

Figure 5.6 Buttons for zooming in or out of a graphic
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5.10), depending on the marking mode. (See Figure 5.8.) Objects that have been
marked can be identified by the markers that have been placed around them9).

With most objects there is no difference between the two marking modes. For
objects like polygons, however, which are defined by several base points, the two
modes have a different meaning. When marking such an object by its individual
points, the position of each base point can be changed individually using the
mouse. This results in the object changing its form, i. e. the form of its bounding

 

Figure 5.7 Spectrum „blow-up“

Figure 5.8 The icons for the marking modes

9) The marker size can be changed in the Global Setup.

3.03.54.04.5 ppm

x16
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box. When an object is marked as a whole (Figure 5.10), only the objects dimen-
sions can be changed, but not its individual point positions.

To mark more than one object you have to select each item with the left mouse but-
ton while holding down the Shift modifier key. Several objects can be marked
simultaneously with the mouse by putting a frame around them. Place the mouse
cursor outside the layout region to be marked, press the left mouse button and
move the mouse over the objects. A frame appears and all objects inside this frame
are marked after releasing the mouse button.

Use the Mark All command from the Edit menu if you want to mark all objects
simultaneously. Mark All implicitly activates marking mode.

5.3.3 Using a spectrum or FID as a clipping window

If modifier keys are pressed while scaling or moving a FID or spectrum, the FID or
spectrum will not change its x position (provided Shift or Alt is pressed) or y posi-
tion (provided Control or Alt is pressed). The FID or spectrum object may thus be
used as a a clipping window.

5.3.4 Deleting marked objects

Delete removes all marked objects.

Figure 5.9 A polyline object marked by its points

Figure 5.10 The same object as in Figure 5.9, this time marked as a whole
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5.3.5 Copying marked objects

The Copy command duplicates all marked objects. After copying an object the
copy is independent from the original object.

5.3.6 Rotating marked objects

Use Rotate to rotate all marked objects by 90, 180 and 270 degrees, respectively.

5.3.7 Creating object groups

Sometimes operations like moving or scaling have to be applied to a number of
objects. In this case it may be convenient to combine all of these objects into a
group. Before a group can be created at least two objects have to be marked. Click
on the Group button or use the Group menu entry to combine the objects.

If all the objects within a layout are intended to be part of a group, the menu com-
mand Mark All can be used as a shortcut for selecting all the objects at once.

To split a marked group into its individual parts, use the Ungroup button in the
layout window or the menu bar.

5.3.8 The stacking order

If a layout contains overlapping objects, you may want to move an object to the
foreground or background. The commands Raise and Lower in the Edit menu are
provided for this purpose. The command Raise places the marked objects in the
foreground, while the command Lower places them in the background.

5.4 The Popup Menu

Pressing the right mouse button or the [F4] function key10) will automatically
mark the object under the cursor and display a popup menu that contains the most
frequently used commands (Figure 5.11). This is especially useful if you want to
edit an object.

10) On many Unix type systems the popup menu will not work as long as the NUMLOCK state is 
activated on your keyboard. Press the NUMLOCK key again to deactivate it. This behavior 
cannot be influenced by XWIN-PLOT
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5.5 Attributes

The Attributes Selector (Figure 5.12) is displayed by clicking on the Attributes
button. If one of the creation modes (Chapter 5.2.1) is active, after clicking Apply
or OK all changes made in the Attributes Selector will affect objects created subse-
quently. If one of the marking modes (Chapter 5.3.2) is active, the attributes of the
marked objects can be changed by pressing the Set button. The Reset button will
set all attributes to their default values.

XWIN-PLOT supports two different color models, namely a set of 16 fixed colors
and arbitrary color settings depending on RGB values. The active color is selected
with either the 16 buttons for the standard colors or by activating the RGB color
button. The settings for line and fill colors can be changed independently. You can
switch between the line and fill color settings by selecting the corresponding radio
button.

After clicking on the button RGB Settings, the RGB Settings dialog window will
be displayed (Figure 5.13). RGB colors can be changed by entering red, green and

Figure 5.11 The popup menu
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blue values in textfields or by moving sliders. The current RGB values and the
resulting color are displayed while you are editing. If the number of available col-

Figure 5.12 The Attributes Selector

Figure 5.13 Changing the RGB settings
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ors is exhausted, the color shades shown in the Color field may not reflect the true
values indicated by the contents of the textfields or by the slider positions11). How-
ever, this does not affect the colors as they appear on a printout.

To change the font size, choose one of the font units in the option menu and enter a
value in the Font Size input field.

All the settings of the Attributes Selector can be loaded and saved with the com-
mands available in the File menu.

5.6 Data set handling

5.6.1 The Data Set Selector

The Data Set Selector (Figure 5.14) contains all the data sets available for XWIN-
PLOT. All data sets that are to be displayed as parts of NMR related objects have to
be chosen in this selector first.

The data set that is selected in the Data Set Selector is the one that will be used if
new NMR objects are created. For stacked plot objects, which usually contain

11) The maximum number of different colors depends on the display hardware.

Figure 5.14 The Data Set Selector
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more than one spectrum, the first of these spectra has to be selected in the selector.
All stacked plot spectra are taken from the Data Set Selector in ascending order,
beginning with the active data set.

To select a data set, mark it with the left mouse button and press Apply or OK.
Press Set to change the data set for the currently marked objects. Double clicking
on a data set name selects this data set and closes the selector.

After clicking on the Edit button, the Portfolio Editor will pop up.

5.6.2 The Portfolio Editor

In XWIN-PLOT all actions related to loading NMR data sets are handled by the
Portfolio Editor (Figure 5.15) in combination with the Data Set Selector.

Figure 5.15 The Portfolio Editor
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In the Portfolio Editor NMR data sets can be selected by name. These names are
composed of the data directory the data sets reside in, the user and data set names
and the experiment and processing numbers. Before an NMR data set can be used
in the plot editor, it must be added to the portfolio editors selection list. This is
done by double clicking on the data set entry or by selecting it and clicking on the
Append button. All active data sets are listed at the bottom of the Portfolio Editor
form. With Insert a data set can be inserted into the list of active data sets at an
arbitrary position. The new entry is placed before the active one. Remove deletes a
data set from the portfolio list. Apply finally accepts all selections and updates the
Data Set Selector. The data sets to be displayed in NMR related objects can be
selected from the Data Set Selector, as described in 5.6.1.

The Portfolio Editor‘s File menu provides commands for saving, loading and
appending portfolio contents. By convention portfolio file names end with .por .
If a portfolio is saved as default, it is loaded automatically each time XWIN-PLOT is
started. If the plot editor is started within XWIN-NMR, it additionally searches for a
portfolio named portfolio.por  in the processing directory of the current
dataset and loads that if present. Otherwise the default portfolio remains loaded.
Content of the portfolio is transferred to the data set list. Finally the first entry in
the list is replaced by the current data set, and if there are projections these are
placed on positions 2 to 5. The rest of the portfolio remains unchanged. The
default portfolio data is also used by the XWIN-NMR search  command. The Edit
menu offers options to sort the portfolio data in ascending or descending order and
a Clear command to remove all selections.

With Edit Directory List in the Edit menu you can specify the directories (for-
merly called disk units) that contain XWIN-NMR data files. Directories are valid
data directories if they contain a folder data  with XWIN-NMR data. The directory
list dialog window displays all currently valid directories in a list box (Figure
5.16). Data directories can be added to this list by specifying their name in the
Directory text field and pressing the Return key or the Add button. Select one or
more directories and click on Remove to delete them from the directory list. The
current directory list will be accepted by the Portfolio Editor after clicking on
Apply.



5.7 File handling 49

DONE

INDEX

INDEX

5.7 File handling

All file related functions are found in the plot editor‘s File menu. Select New to
open a new, empty layout window. With Open, a previously existing layout can be
loaded. With Save you can save a layout under its current name. Use Save As if
the layout is to be saved under a new name. Select Abandon to reload the current
layout and discard all changes.

Save Layout/Portfolio to Dataset saves the layout in the processing directory of
the current dataset. Additionally the contents of the current portfolio is saved under
the predefined name portfolio.por . Select Open Layout/Portfolio from
Dataset to open them againt. See also Chapter 5.6 on how the file portfo-
lio.por  is using during startup of XWIN-PLOT.

To close a layout window select the Close menu entry. As soon as the last layout
window is closed, XWIN-PLOT will terminate. XWIN-PLOT also terminates if the
Close All menu option is selected.

Figure 5.16 Editing the data directory list
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5.7.1 Archive functionality 

AUTOPLOT will always store a backup copy of the currently used layout to the first
data set on the list. The backup copy gets the fixed name last_plot.xwp . 

This ensures that you always could exactly reproduce the last plot of this dataset
even when your standard layouts have been changed in the meantime. In that case
use the Open Layout/Portfolio from DataSet command to load
last_plot.xwp  into XWIN-PLOT again.

5.8 Printing a layout

The graphics created by the XWIN-PLOT editor can be printed in high quality on
most printer types, including dot matrix printers as well as ink jet or laser printers.
Additionally a graphic can be saved as a file which can be imported into a text doc-
ument.

To print or preview a layout select the Print menu entry in the File menu.

The Print form (Figure 5.17) allows you to print, save or preview the graphics
according to the settings chosen in the Printer Setup (See chapter 5.11.3 on
page 54.). The Printer Setup may be selected from the Print form or from the
Options menu. You can also select the range of pages to be printed.

Select To File to save the graphic in the natural printer format according to the
printer setup. A graphic that is saved to a file can be imported into a text document.

Figure 5.17 The Print form
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After clicking on Preview a new window is opened and a preview of the current
graphic will be displayed.

5.9 Undo

Any operation on a layout can be reversed by clicking on the Undo button or
choosing the Undo command in the Edit menu. 

5.10 The XWIN-PLOT clipboard

Note: For differences in the Windows version of XWIN-PLOT please refer to Chap-
ter 11.

For copying objects between different layout windows a clipboard mechanism is
available. To display the clipboard window (Figure 5.18) select the Show Clip-
board option in the Edit menu. After marking your objects, they can be copied to
the clipboard by selecting Put to Clipboard in the File menu.

Figure 5.18 The clipboard with an object in it
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The clipboard contents can be zoomed using the Zoom In and Zoom Out buttons.
With Get from Clipboard the clipboard data is copied to the active layout win-
dow. Clear Clipboard removes the clipboard contents12). 

5.11 Setting up XWIN-PLOT

All setup-related options are found in the Options menu and will be described in
the following sections.

5.11.1 The Global Setup

Within the Global Setup shown in Figure 5.19 you can change some general
parameters. The Global Setup dialog window is displayed after selecting the corre-

sponding menu entry.

12) This operation cannot be reversed by Undo.

Figure 5.19 The Global Setup dialog window
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Each layout window has a status line below its drawing area which contains infor-
mation about the current mouse cursor position, the size of the active object or a
data set name. Deselect the button Show Status Lines if you do not want this
information to be displayed. Removing the status line will provide additional space
for the graphics. If Show Toolbar Hints is enabled, small popups providing a
short help text are displayed when the mouse stays a certain time over a particular
button in the layout window. XWIN-PLOT displays a dialog window with helpful
tips about certain program features each time the program is started, if the option
Show Startup Hints is selected (Figure 5.20).

Depending on your screen resolution it may be necessary to change the size of the
markers XWIN-PLOT displays around marked objects. The marker size can be
changed with the slider Marker Size (in pixel).

In the Global Setup dialog you can also set the parameters for the „blow-up“ func-
tion that is available in expand mode (See chapter 5.2.2 on page 39.).

The settings made in the Global Setup are automatically saved when leaving
XWIN-PLOT.

5.11.2 The Layout Setup

In addition to the global settings made in the Global Setup, for each layout window
there is a Layout Setup with options that affect only the current layout window.
(See Figure 5.21.)

Usually objects are not placed arbitrarily on the screen but their positions are
aligned horizontally or vertically. XWIN-PLOT provides an invisible grid which

Figure 5.20 A startup tip
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helps in aligning objects. The grid distance is selected by the radio buttons under
Snap-In. When placing an object on the screen the mouse cursor will automati-
cally jump to the locations marked by the grid13).

5.11.3 The Printer Setup

Note: For differences in the Windows version of XWIN-PLOT please refer to Chap-
ter 11.

The Printer Setup dialog window (Figure 5.22) contains all printer related options.
The setup data is saved automatically, together with the layout information, if you
choose Save or Save As from the layout window‘s File menu.

The XWIN-PLOT plot editor comes ready for use with a variety of printers. Select
your printer from the Printer Type list at the top of the Printer Setup dialog win-
dow. If you have a printer with built-in PostScript support choose the PostScript
entry. Otherwise select the entry corresponding to your printer name. If your
printer is not listed, you will have to choose an entry that is compatible with your
printer, i. e. a printer which offers the same printer emulation as yours. Please con-
sult the printer manual if you are in doubt about the emulation mode needed for
your printer. Most dot matrix printers have built-in Epson emulation, a lot of laser
printers are compatible with the HP LaserJet series. Ink jet printers usually are
compatible with the HP DeskJet or the Canon BubbleJet. If no information about

Figure 5.21 The Layout Setup

13) The Snap-In settings have no effect in expand and zoom mode.
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the printer emulation is available it is a good idea to try some of the predefined
printer types. Choosing the wrong emulation will not harm a printer, but it will
give bad or no results. On the other hand, if the printer output is identical to the
graphics on the computer screen, you can be quite sure that you have found an
emulation compatible with your printer type.

Figure 5.22 The Printer Setup dialog window
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The Printer Type list also contains entries for creating graphic export files. An
important entry of this type is EPSI14). Choose this entry if you want to import
your graphic into programs that support Encapsulated PostScript import, e. g.
FrameMaker or Corel Draw.

XWIN-PLOT recognizes most common paper formats which can be selected in the
Paper Size list. Because of their mechanics most printers do not utilize the full
area of a sheet of paper. To ensure that parts of a layout do not exceed the printable
paper size, printer offsets have to be specified for each edge of the page. Usually
these values need not to be changed since the default values work with most
printer types.

The Paper Size settings have an effect on the printer output as well as on the
screen layout of the plot editor‘s layout windows. If the paper size or offsets are
changed, the dimensions of the screen layout are adjusted accordingly after press-
ing Apply or OK.

The XWIN-PLOT editor supports both the Portrait and the Landscape output for-
mat. Choose one of these formats from the Output Format options. Switching
between the Portrait and the Landscape format will also affect the current layout. If
a color printer is available you can choose between monochrome or color print-
ings. It is recommended that the color option is used with color printers only and
not with black and white ones. Otherwise the graphics might be modified by the
printer or the printer driver in order to visualize different color shades. In this case
the Color option does not give satisfying results on most black and white printers.

If the desired size of a printing job is larger than the physical paper size, e. g. for a
poster, it can be split and distributed over several sheets of paper. To print the
graphics on several pages, select the number of pages for each dimension using
Split to X*Y Pages. These pages can be fit together at their edges later on. The
screen layout will display the splitting settings after pressing Apply or OK.

As XWIN-PLOT was preconfigured to directly work with a standard SVR4 Unix
environment, the Print Command and Preview Command options at the bottom
of the Printer Setup form in most cases will only have to be changed in a non-stan-
dard environment. With Print Command you can define the command string the
plot editor uses when transferring the plot data file to the printer spooler. A valid
command string might look like this:

14) Encapsulated Postscript Interchange
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lp -c -s -oraw -n1 -dMyPrinter %s

lp  is the name of the standard Unix printer spooler program to be used, followed
by several options:

• The -c  option tells lp  to copy the print code file and print the copy instead of
the original file. This option must not be omitted since the print code file will be
deleted immediately after executing the lp command. 

• The -s  option prevents lp  from reporting status messages about the print job.

• The -oraw  option tells lp  to work in raw mode, i. e. data is not interpreted.
This option must not be omitted.

• The -n  option specifies the number of copies to be printed, e.g. -n2  for two
copies. If you just want to have one copy, this option can be omitted.

• The -d  options tells lp  which printer to use, e.g. use -dMyPrinter  to print
on the printer with the name MyPrinter . If you want to use the default
printer, this option can be omitted.

• The option %s stands for the name of the file to be printed and is automatically
replaced by an appropriate filename during runtime. The %s must not be omit-
ted.

If the BSD printer spooler is running on your machine, the command for printing
with XWIN-PLOT will probably be (use this on Linux systems):

lpr -h -#1 %s

The option -h  will suppress the printing of the burst page. With -#  the number of
copies can be specified.

The Preview Command textfield defines the command which runs the PostScript
previewer. On an SGI platform the xpsview software package is used as default
previewer.

Once you have selected printer settings reflecting your configuration and your
needs, the new setup can be activated by clicking on Apply or OK. If you want to
exit without the changes taking effect, choose Cancel.
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To select the current printer configuration as the default setup, use the Save As
Default option in the Printer Setup‘s File menu. Use Save As for saving the cur-
rent printer setup with a specific name. The setup can be retrieved later using the
Load command.

5.12 On-line help

The complete XWIN-PLOT manual is available in a Hypertext help format. Help
texts are displayed after selecting the corresponding entries in the Help menu.
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Object editors

XWIN-PLOT supports a variety of object editors:

• There are several standard object editors which allow for the setting of all rele-
vant parameters for all graphic objects.

• There is a special 1D object editor for FIDs, T1/T2 curves and 1D spectra and a
special 2D object editor for 2D spectra.

• The Attributes Selector (see Chapter 5.5 on page 44) can be used to modify an
object‘s graphic attributes.

• The Data Set Selector (see Chapter 5.6 on page 46) can be used to change an
object‘s data set.

6.1 Standard object editors

After marking an object and clicking on the Edit button one or more standard
object editors will be displayed. The number and types of these editors depend on
the type of the object for which the edit command was called. For simple objects
like rectangles only the basic object editor will be displayed. For more complex
objects there are additional object editors.

As long as an object is being edited it cannot be modified in the layout window.
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6.1.1 The basic object editor

With the basic object editor the position and dimension of an object can be set.

Note that the position and dimension are the logical position and dimension, not
the position and dimension of the bounding box. The markers placed around
objects (see Chapter 5.3.2 on page 40) show the logical position and dimension,
while the dotted rectangle that appears as soon as the mouse cursor enters an
object, shows the position and dimension of the bounding box.

The logical position and dimension and the position and dimension of the bound-
ing box only differ for a few objects, e.g. for a line object with arrow tips or for a
spectrum or FID object with axes and the option Scale Bounding Box set to false.

After clicking on the Basic button an attribute editor will pop up. This editor
allows you to change the marked objects attributes. The Basic button can only be
used to select objects that support basic editing functions.

6.1.2 The arrow object editor

Arrows tips can be added to lines and bezier curves. When editing these objects the
arrow style and tip width can be selected as shown in Figure 6.2. If you want a
filled arrow tip, use the basic attributes to set the fill style and the fill color accord-
ingly.

6.1.3 The EPSI object editor

Note: For differences in the Windows version of XWIN-PLOT please refer to Chap-
ter 11

Figure 6.1 The basic editor
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For EPSI objects the EPSI object editor (Figure 6.3) provides the means to select

an EPSI file which is to be displayed inside an EPSI object. After clicking on
Select the EPSI file can be specified in the file selector. EPSI objects can use EPSI
files relative to the current data set. Then the same layout will include different
graphics for different data sets. When entering the filename you can specify the
path as specified on page 15. You can also use absolute paths to use always the
same graphics file.

By default, XWIN-PLOT will resize the graphics so it will never exceed the bound-
aries of the EPSI object. This may result in distortion of the graphics. Checking the
option Always maintain aspect ratio ensures the graphics will not be distorted if
the aspect ratio of the EPSI graphics differs from that of the object while still resiz-
ing it. When Always resize graphics to fit in boundaries is unchecked the graph-
ics will not be resized at all and possibly clipped off by the boundaries of the EPSI
object.

It is possible to set up the EPSI object editor to recalculate the position and dimen-
sion of the EPSI object according to the aspect ratio provided by the postscript file
when pressing OK or Apply (Figure 6.4).

Figure 6.2 The arrow object editor

Figure 6.3 The EPSI object editor
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6.1.4 The text object editor

Text objects can be aligned vertically and horizontally by selecting vertical or hor-
izontal alignments. (See Figure 6.5.) You can also edit the text by selecting Edit

Text. A dialog window with a simple text editor will be displayed. The button
Character Chart displays a chart showing all available characters of the current
character set, including those that cannot be typed on the keyboard. To select one
of these characters click on the corresponding button. The character will be
inserted in the current text at the text cursor position.

With Load Text the text to be displayed can be loaded from a text file. After load-
ing the text you can edit it with Edit Text. Note that the contents of this kind of
text object can only be changed manually. Sometimes it is desirable that the actual
text is read from a file and that there is a unique text file for each NMR dataset.
The NMR text object has to be used in this case. “The NMR text object editor” on
page 78 provides more information.

When making changes to the text alignment, it may be necessary that the hot point
remains unchanged15). For this purpose an additional option should be used (Fig-
ure 6.8). When changing a text objects contents, the object dimensions often

Figure 6.4 Resetting the aspect ratio of EPSI objects

Figure 6.5 The text object editor
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change, too. If the switch Recalculate Object Dimensions is activated, XWIN-
PLOT will adjust the objects edges to fit the new size text object exactly. With some
objects, especially those with centered text, this may give undesired results. If you
don‘t want the text object‘s size to be affected after changing the text, deselect this
option. The hot point option and the recalculation option do not change the object
directly but only the way OK or Apply work on this object.

6.1.5 The resizable text object editor

Text objects can be set up to change or not to change the font size automatically
after scaling. This can be done by enabling or disabling the button Allow auto-
matic font resize (Figure 6.9).

15) The hot point is the text‘s anchor point.

Figure 6.6 Editing a text object
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Figure 6.7 The character chart

Figure 6.8 Options for editing text objects

Figure 6.9 The resizable text object editor
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6.1.6 The graph object editor

The graph editor (Figure 6.10) provides basic operations that can be applied to all
objects which support axes and grids. The horizontally and vertically visible parts

of a spectrum are affected by the data in the Xmin, Xmax, Ymin and Ymax text-
fields. Horizontal and vertical axes or grids can be switched on and off with the
corresponding toggle buttons. The X-Axes Offset and the Y-Axes Offset, resp.,
change the distance between the spectrum and its axes.

By default, the logical position and dimension of a graph object is the position and
dimension of the curve that is displayed within this object. If you want the logical
position and dimension of the graph object to be the same as the position and
dimension of the graph object‘s bounding box, activate the button Scale Bounding
Box. This is useful if you intend to group a graph object with a frame and want to
scale this group. You should not activate Scale Bounding Box in order to group a
graph object with text and line objects that serve as annotations. Scaling such a
group with Scale Bounding Box activated will change the relative positions of the
annotations to the curve of the graph object.

When Draw Box around Curve is selected, XWIN-NMR places a box around the
curve object. For 2D spectra this is the default behavior.

Figure 6.10 The graph editor
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For each part of a graph object the basic attributes may be set independently. This
enables you, for example, to assign a spectrum‘s axes a color different from the
spectrum itself. To change the attributes of the spectrum‘s curve, the axes or the
grids, click on one of the corresponding buttons Curve, Axes or Grid. This will
pop up the attribute editor.

6.1.7 The 1D spectrum object editor

The 1D spectrum object editor provides additional functions for 1D spectrum
objects (Figure 6.11).

XWIN-PLOT can add peak labels and integral data to a spectrum, depending on the
way a data set was processed in XWIN-NMR. If present, the additional information
will be displayed after selecting the appropriate toggle buttons. The format for dis-
playing numerical peak and integral data can be configured in the corresponding
text fields. The notation for specifying the display format, in particular the number
of digits to be displayed, is identical to the one used in the C programming lan-
guage16). The default format is

%.3f

Figure 6.11 The 1D object editor

16) See the on-line manual page for more information by executing the command man 
printf  in a Unix shell.
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which denotes that the data is to be displayed in a floating point format with three
decimal places.

The units for axes and peak labels can be chosen independently. The graphic
attributes of peaks and integrals may be changed as well as the attributes for
curves, axes and grids.

6.1.8 The 1D stacked spectrum object editor

With the stacked plot editor you can change the look of stacked plot objects. (See
Figure 6.12.) The horizontal and vertical distance between the individual spectra of

a stacked plot can be selected within the Spectra Offset text field.

Figure 6.13 gives an example of a white washed stacked plot that was created with
XWIN-PLOT. As you will notice, only the lines in the foreground are visible. This is
the result of setting the fill color in the stacked plots curve attributes to white and
the fill style to „filled“. If Set Curve Attributes to White Wash is active when
pressing OK or Apply, XWIN-PLOT will automatically set the curve attributes this
way. Change the curve attributes to the standard values if you want to remove the
white wash look.

Before spectra can be combined to a stacked plot, they have to be added to the
Data Set Selector. The active spectrum in the selector is the first to be displayed in
the plot. The additional spectra for the stacked plot are those listed in ascending
order behind the selected spectrum.

When creating the spectra list for the Data Set Selector in the Portfolio Editor, it is
often beneficial to use the sorting options in the portfolio‘s Edit menu to ensure
the correct order of spectra. Usually either an ascending or a descending order is
preferable. It is recommended that the data set names for spectra that are intended
to be used in a stacked plot are selected in such a way as to allow efficient sorting
for the order needed for the plot. For temperature dependent spectra, for example,

Figure 6.12 The stacked plot parameters
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this means that the data set names should contain information about the acquisition
temperature. In stacked plots such spectra usually are displayed according to rising
or falling temperatures, so data set names with the temperature as one of their com-
ponents will guarantee that a particular order can easily be achieved.

6.1.9 The 2D spectrum object editor

When editing 2D spectra, the units may be chosen separately for each of the two
axes. The graphic attributes for negative and positive levels can be selected glo-

Figure 6.13 A white washed stacked plot

Figure 6.14 Setting white wash attributes

4.54.64.74.84.95.05.1 ppm



6.1 Standard object editors 69

DONE

INDEX

INDEX

bally. Use the interactive 1D/2D editor to change the color settings for a particular
level.

6.1.10 The 2D projection object editor

This editor allows to select 1D spectra that will be displayed as projections at the
axes of a 2D NMR spectrum. Each axis has a toggle button which allows to display

the corresponding projection (Figure 6.16). To select a projection data set, click on
the buttons Top Data Set, Bottom Data Set, Left Data Set and Right Data Set,
respectively. The Data Set Selector will pop up and you can select the data set to
be displayed. The projection size can be changed in the corresponding text fields.
All projections have identical graphic attributes which can be edited by clicking on
the Attributes button.

Figure 6.15 The 2D object editor

Figure 6.16 The 2D projection editor
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6.1.11 The T1/T2 object editor

XWIN-PLOT is capable of displaying T1/T2 curves created by the XWIN-NMR relax-
ation (T1/T2) routine. In the T1/T2 object editor the curve attributes can be
changed (see Figure 6.17). For each of the T1/T2 relaxation point lists you can edit

the graphic attributes by clicking on a list entry while the button Edit Attributes is
active. Click on Edit Markers and select a list entry afterwards in order to change
the marker type and size in the Marker Selector (Figure 6.18). Optionally tags

Figure 6.17 The T1/T2 object editor

Figure 6.18 The Marker Selector
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identifying a curve can be displayed on the left or right of each curve. Show Anno-
tation will display an annotation below the T1/T2 object. The graphic attributes
for the tags and the annotation can be chosen independently. Figure 6.19 demon-
strates how a T1/T2 plot can look like. Note that the start and end points of the hor-

izontal scale are taken from the minimum and maximum information provided by
the corresponding JCAMP file containing the T1/T2 data. The range of the scale
can be changed in the graph object editor.

6.1.12 The NMR object editor

When editing NMR-related objects, you can choose a new data set for the current
object in the NMR object editor (see Figure 6.20). After clicking on Select from
Portfolio the Data Set Selector will pop up and another data set can be selected as
already described in Chapter 5.6.

Figure 6.19 An example of a T1/T2 plot
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Peak No. 3, Cursor Point = 5478, 323.76 Hz, 0.899 ppm (3)
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Peak No. 8, Cursor Point = 5530, 297.95 Hz, 0.827 ppm (8)
Peak No. 9, Cursor Point = 5656, 235.43 Hz, 0.654 ppm (9)
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6.2 The 1D/2D object editor

The way how a 1D object, e. g. a spectrum or a FID, is displayed can be changed
by using the interactive editing facilities available after clicking on the 1D/2D-
Edit button while a 1D object is selected. 1D and 2D objects can also be edited by
using the extended editing mode which can be entered by selecting the Edit but-
ton. The interactive editing mode provides tools for changing the dimensions of a
1D or 2D object as well as adding or removing axes and grids.

The 1D/2D object can be moved vertically or horizontally with the tools on the left
of the toolbar‘s upper row. When clicking on one of the icons with the left mouse
button and keeping the button pressed, you can change the spectrum‘s position by
moving the mouse in the directions indicated by the arrows inside the icons.

Figure 6.20 The NMR object editor

Figure 6.21 Interactive 1D/2D editing
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By using the two icons on the right of the upper row the graphic can be expanded
horizontally or vertically. As long as the mouse button remains pressed and the
mouse is being moved the spectrum or FID will change.

Use the EXPAND button to expand the spectrum in all directions simultaneously.
Moving the mouse pointer upwards results in the object being magnified. Moving
the pointer downwards reduces the object size.

If a 1D graphic is to be stretched vertically by well defined values you can multi-
ply or divide its height by 2 or 8. Applied to a 2D object the level values of the
object will be affected by the multiplication or division.

With the next group of editing tools the object‘s edges can be adjusted to exactly
fit the object‘s dimensions. Each edge can be adjusted separately. When clicking
on the icon on the right the spectrum‘s edges are reset to their original values.
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XWIN-PLOT provides axes that can be displayed outside the 1D/2D object. A hori-
zontal or vertical grid inside the spectrum area is also provided. (See Figure 6.22.)

The type of axes or grids can be selected using the corresponding toggle buttons.

6.2.1 Additional functions for 1D spectrum objects

When editing 1D spectrum objects the 1D/2D editor will display additional fea-
tures. On top of the edit dialog window you can choose if interactive editing oper-
ations affect spectra or integrals or both (Figure 6.23). 

Figure 6.22 A spectrum with a horizontal and a vertical grid

Figure 6.23 Selecting the editing scope
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Peak labels and integral curves can be added to 1D spectra objects by activating
the Show Peaks and Show Integrals options, respectively. (See Figure 6.24.)

It is often necessary to have a well defined relationship between the frequency
scale and a spectrum‘s width, especially for spectra comparison and when analyz-
ing coupling patterns. Therefore, at the bottom of the interactive editing form you
can choose the scale type as well as its units.

The frequency scale can be normalized in Hz per cm or ppm per cm. The scale can
also be justified with an offset. You can display the current settings with Get Val-
ues. The new data is applied to the current spectrum object with Use Values.

6.2.2 Additional functions for 2D spectrum objects

Called for a 2D NMR spectrum, the 1D/2D object editor provides facilities for
interactively changing the appearance of 2D projections as well as maintaining the
list of levels created with XWIN-NMR (Figure 6.26).

Scrolling and scaling of 2D projections works like already described for 1D spec-
tra. The projection to be affected (top, bottom, left, right) is chosen with a radio
button.

The 2D object editor displays a list containing the positive and negative 2D level
values as defined within XWIN-NMR. New levels are added to this list by entering

Figure 6.24 The options for adding peak labels and integral curves

Figure 6.25 Changing units and offsets
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their value in the Value text field and clicking on Add. Use the Remove button to
delete one or more entries from the list. After clicking on Edit the 2D Level Cre-
ator window will pop up. There you can create an entirely new level list based on

Figure 6.26 Editing a 2D spectrum and its projections

Figure 6.27 New level lists can be created with the 2D Level Creator
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base level values and an incremental factor17). If new positive levels are to be cre-
ated enter a positive base level in the Positive Base Level input field. The positive
base level must not be smaller than 100. The base level for negative levels must be
-100 or lower and is entered in the Negative Base Level field. With Total number
of Levels you can specify how many new levels will be created. The number of
levels applies for positive and negative levels separately. For both negative and
positive ranges new values are only created if a base level is supplied. Otherwise
the already existing levels for each range (positive or negative) are preserved.

To change the color of a particular level, select this level in the level list and click
on one of the color button in the 2D level Color Setup. The change will show an
effect after clicking on Apply.

Often level data are represented best by a color flow where the colors between two
adjacent levels differ only slightly. XWIN-PLOT creates this effect automatically
when the button Create Color Flow is selected. This button is disabled unless
exactly two levels are selected in the level list18). The colors of these levels are the
basis for the creation of new RGB colors that will be assigned to all the levels
between those chosen. Figure 6.28 gives an example of a 2D spectrum with colors
automatically calculated by the Create Color Flow option.

It is recommended that you make some experiments with the color flow option in
order to get an impression what the results look like.

When you use a layout with some assigned level colors on several different data
sets the number of levels in the original layout and each data set might not match.
XWIN-PLOT then automatically tries to adapt the colors to get an acceptable result. 

If you always want to have one fixed color (e.g. blue) for all positive and another
fixed color (e.g. red) for all negative levels simply create a 2D object with only
two levels, one positive and one negative, assign the desired colors and save it.
When using this layout on a data set with more than two levels XWIN-PLOT will
extend your color assignment to ensure the desired result.

17) Note that any changes to the level list have an effect in XWIN-PLOT only and do not affect 
the level data created with XWIN-NMR.

18) Under Motif multiple selections are handled by using the modifier keys Shift or Control 
in addition to a mouse click.
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6.3 The NMR text object editor

In addition to the standard text objects that can be created in the Basic major edit-
ing mode XWIN-PLOT provides for special dataset-related text objects. These
objects display a variable text instead of a fixed one. The text is read from a text
file whose name is entered in the NMR text object editor (Figure 6.29). When

Figure 6.28 A 2D spectrum displaying automatically created colors

Figure 6.29 The NMR text object editor
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entering the filename you can specify the path as specified on page 15. You can
also use absolute paths.
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Automation editors

The automation editors are called with the Automation Parameters entry in the
Edit menu. This entry is only enabled if an object supporting automation parame-
ters is selected.

7.1 Reset actions

The automation editors provide options for controlling the behavior of 1D and 2D
objects in respect to a reset of these objects. Each automation editor contains
options that affect an object‘s X and Y dimension separately.

7.1.1 General reset actions

All automation editors have some reset actions in common. For the X dimension
these reset actions are:

• Don‘t change: Xmin/Xmax will not be changed on a reset.

• Set to minimum/maximum: Xmin will be set to the minimum x value. Xmax
will be set to the maximum x value.

These are the general reset actions for the Y dimension:

• Don‘t change: Ymin/Ymax will not be changed on a reset.
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• Set to minimum/maximum: Ymin will be set to the minimum y value. Ymax
will be set to the maximum y value.

7.1.2 The FID automation editor

The FID automation editor (Figure 7.1) provides options that control the reset
behavior of FID objects.

These are the additional reset actions for the Y dimension:

• Set to minimum/maximum between Xmin/Xmax: Ymin will be set to the
minimum y value between Xmin/Xmax. Ymax will be set to the maximum y
value between Xmin/Xmax.

Figure 7.1 The FID automation editor
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7.1.3 The 1D automation editor

The way in which the 1D spectrum reacts in case of a reset can be selected within
the 1D automation editor (Figure 7.2).

Figure 7.2 The 1D automation editor
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The additional reset actions for the X dimension of a 1D spectrum have the follow-
ing meaning:

• Set to F1P/F2P: Xmin will be set to the value of the parameter F1P in the data
set, Xmax will be set to the value of F2P. Use this when the 1D spectrum
should use the same axis limits as used in XWIN-NMR. This can also be useful in
AU programs. Axis limits of the plot then can be controlled by setting the
parameters F1P/F2P prior to the AUTOPLOT command.

These are the 1D spectrum object‘s specific reset actions for the Y dimension:

• Set to minimum/maximum between Xmin/Xmax: Ymin will be set to the
minimum y value between Xmin/Xmax. Ymax will be set to the maximum y
value between Xmin/Xmax.

• After reset size of biggest peak is: After Ymin/Ymax have been calculated
according to the selected action, Ymax will be rescaled with a user-defined fac-
tor. You can choose to define the new size in percent of the object size (the
default value 100% results in no changes). Alternatively, you can specify the
absolute new size in centimeters here, or tell XWIN-PLOT to get the new size in
centimeter from the parameter CY in the data set. Together with the F1P/F2P
option above the last option can be used in AU programs to have full control
over plot limits and scaling. 

If Use region file „reg“ on reset is activated, the reset action for Ymin/Ymax will
only take into account the regions defined in the file reg, intrng (See chapter
3.5 on page 19.), or defined by the contents of the parameter SREGLST in the data
set.

7.1.4 The 2D automation editor

With this automation editor (Figure 7.3) you define how a 2D spectrum reacts to a
reset. 

The additional reset actions of a 2D spectrum have the following meaning:

• Set to F2PLO/F2PHI: Xmin will be set to the value of the parameter F2PLO
in the data set, Xmax will be set to the value of F2PHI. 

• Set to F1PLO/F1PHI: Ymin will be set to the value of the parameter F1PLO
in the data set, Ymax will be set to the value of F1PHI. 



7.1 Reset actions 85

DONE

INDEX

INDEX

Use these options when the 2D spectrum should use the same axis limits as used in
XWIN-NMR. Again, this can also be used in AU programs to control axis scaling by
setting the parameters F2PLO/F2PHI/F1PLO/F1PHI.

For each of the possible four projections then same reset actions are available as
used for stand-alone 1D objects.

Figure 7.3 The 2D automation editor
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Reusing layouts

An outstanding feature of the XWIN-PLOT plot editor is its layout support. A layout
is a graphics template that was created for particular data sets and saved for reuse
with other data sets. When saving a layout, only the layout information, e. g. object
positions and dimensions, are saved, not the actual data set information. This chap-
ter describes how to reuse a layout in order to use XWIN-PLOT efficiently.

8.1 Layouts and data sets

The basic steps for reusing layouts are shown in Figure 8.1. This steps consists of:

• Loading the layouts

• Loading the data sets

• Resetting the layouts

• Printing

8.1.1 Loading layouts

Layouts can be loaded by using Open from the File menu. If you want to use more
than one layout, first use New to get a new layout and then Open to load the addi-
tional layout.
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If you are using the stand-alone version of XWIN-PLOT, you can also load layouts
by specifying the layout file names on the command line. (See chapter 2.2 on
page 13.)

8.1.2 Loading data sets

Data sets may be loaded in the following ways:

• With the Portfolio Editor you can load arbitrary data sets. (See chapter 5.6.2 on
page 47.)

• Get Current Data Set in the XWIN-NMR menu loads the current XWIN-NMR

data set. Use Get Current Data Set + Reset if you also want to reset a layout.
Use Get Current Data Set + Reset + Print to additionally print the layout.
Note that these commands are only available in case XWIN-PLOT was started
from within XWIN-NMR.

Figure 8.1 Reusing layouts

Load layout(s)

Load data sets

Reset

Print layout(s)



8.2 Printing a series of spectra 89

DONE

INDEX

INDEX

8.1.3 Reset

A reset executes the reset actions of NMR objects. The reset actions can be used to
rescale a spectrum automatically. (See chapter 6.1.7 on page 66.)

To issue a reset you can either mark individual objects and use Reset Marked
Objects in the Edit menu, or you can reset all objects with Reset All Objects in
the Edit menu. A reset is done automatically by the Get Current Data Set +
Reset command.

8.1.4 Print

To print a layout use the Print command from the File menu. (See chapter 5.8 on
page 50.) If you use the command Get Current Data Set + Reset + Print from
the XWIN-NMR menu, the layout will be printed automatically.

8.2 Printing a series of spectra

To reuse layouts is very convenient when a series of spectra is to be printed. With
XWIN-PLOT several spectra can be printed easily using the plot editors Multi-Print
capability, available in the File menu. In the Multi-Print dialog window you can
print groups of data sets combined with all open layouts.

To use this feature the layouts that are to be used for printing have to be loaded
first. Now the data set portfolio has to be prepared. In order to fill the Portfolio
with data enter the Portfolio Editor and put all data sets that are to be printed in the
data set portfolio. If more then one data set is used by the layouts, enter the number
of data sets in the Multi-Print dialog. Now simply press the Print button to get
printouts of all layout and data set combinations.
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Figure 8.2 Printing multiple data sets
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Autoplot AU Macro Reference

Once you have created some standard layouts according to your personal needs a
simple autoplot command can be used to produce the plot without any further
user interaction. autoplot can be typed at the XWIN-NMR prompt and becomes
really important when you include plotting tasks in AU programs.

autoplot, together with the necessary arguments, can be entered and started on
a standard shell prompt. For efficient use in AU programs a collection of AU mac-
ros is available. There are macros to autoplot itself as well as macros to collect sev-
eral datasets in a portfolio. Use of a portfolio instead of the current dataset lets you
include more than one dataset in the layout. 

9.1 Plotting the current data set

AUTOPLOT

The macro AUTOPLOT executes the autoplot command without any further
arguments. 

The name of the layout will be taken from the LAYOUT parameter in the current
dataset (see the edo dialog). A portfolio file portfolio.por will be loaded if
found in the processing directory of the current dataset. Otherwise the default port-
folio will be used. Its first entry will always be set to the current dataset. If projec-
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tions have been calculated these will be included in the portfolio at positions two
to five. Other entries remain unchanged. This works exactly the same way as if
XWIN-PLOT was started within XWIN-NMR.

AUTOPLOT uses the printer that has been specified in the layout file. To change
the printer setting of a layout, open the layout with XWIN-PLOT, choose anther
printer setting in the Printer Setup dialog, and save the layout again. 

Example code as it could be used in an AU program:

GETCURDATA
AUTOPLOT

9.2 Plotting arbitrary data sets

To plot more than one dataset in a layout you need to create a portfolio file specify-
ing those datasets. The following AU macros are provided to create and declare
portfolio files.

DECLARE_PORTFOLIO

This macro prepares the AU program for the use of the other portfolio macros. It
must be included at the beginning of the AU program.

CREATE_PORTFOLIO(“ filename” )

This creates a portfolio file named filename. You must do this before the first
use of a ADD_TO_PORTFOLIO / ADD_CURDAT_TO_PORTFOLIO statement.
The filename is taken without any further modification. It is a good idea to specify
an absolute path to a location that can be safely used, e.g. in the temporary folder
or in your home directory (see the example below).

ADD_CURDAT_TO_PORTFOLIO

The current data set is added to the portfolio list.
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Closes the portfolio definition and makes it ready for use.

AUTOPLOT_WITH_PORTFOLIO

Executes the autoplot command. Instead of the standard portfolio search order,
the portfolio file is loaded that has been constructed with the recent
CREATE_PORTFOLIO / CLOSE_PORTFOLIO instructions. Note that for tech-
nical reasons this macro will not automatically the peak list and / or parameter list
as documented for the autoplot command on page 17.

AUTOPLOT_WITH_PORTFOLIO_TO_FILE(“ filename.ps” )

This works like AUTOPLOT_WITH_PORTFOLIO. The output is not sent to the
printer but to the specified Postscript file instead. The Windows version addition-
ally supports the suffix “.emf”  to create an Enhanced Metafile. Note that for
technical reasons this macro will not automatically the peak list and / or parameter
list as documented for the autoplot command on page 17.

Example

/* A small AU example
**
** The current dataset shall have three PROCNOs
*/
DECLARE_PORTFOLIO

GETCURDATA
CREATE_PORTFOLIO(“ /tmp/myPortfolio.por” )
ADD_CURDAT_TO_PORTFOLIO

IPROCNO
ADD_CURDAT_TO_PORTFOLIO
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IPROCNO
ADD_CURDAT_TO_PORTFOLIO

CLOSE_PORTFOLIO

/* Go back to the initial dataset to use
** the correct LAYOUT parameter
*/
DPROCNO
DPROCNO

AUTOPLOT_WITH_PORTFOLIO
AUTOPLOT_WITH_PORTFOLIO_TO_FILE(“ /tmp/myPlot.ps” )

QUIT

For more information you may want to check the AU programs xwp_p1dlf,
xwp_p2dpl and xwp_pcpd135. They are usually installed with the command
expinstall.
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Tips and tricks

XWIN-PLOT offers a lot of useful features and it surely will take some time before
you can exploit all of them. The more familiar you get with the plot editor the more
you will learn how to use its tools to create sophisticated layouts. The intention of
this chapter is to provide some valuable hints on the use of some of the editor‘s
features that might not come to your mind immediately.

10.1 A shadow around a spectrum

XWIN-PLOT does not offer a predefined object of the type „Spectrum inside a
frame“ like the one shown in the previous examples. It is easy, however, to create
such an object by combining a filled rectangle with a spectrum. The result is
shown in Figure 10.1. Figure 10.2 demonstrates how the layout in this example
was combined with three objects, namely the spectrum a), a rectangle filled with
the color white b) and finally a black rectangle c). The spectrum was surrounded
by an empty rectangle and both objects were grouped with the Group command in
the Edit menu. The resulting object was placed in front of a filled rectangle of the
same size and both objects were combined to a group. This way you get a single
object which looks like the one in Figure 10.1. Because the object‘s components
are bound into a single group, the resulting object can be moved, scaled etc. like a
single object.
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10.2 Import and export of graphics

XWIN-PLOT supports full import and export of graphics on both platforms Unix
and Windows. On Unix systems the EPSI format (Encapsulated Postscript Image)
is typically used, whereas on Windows the WMF/EMF format (Windows Metafile
/ Enhanced Metafile) is the de facto standard. Like EPSI, WMF graphics are com-
pletely rescalable without loss of quality. With EPSI and WMF objects, XWIN-
PLOT is open to the best high-quality graphics on each platform. 

The layout files are freely interchangeable between the two platforms. However,
due to the missing support by the operating systems, WMF graphics will not be
displayed or printed on Unix systems, and EPSI graphics will not be displayed or
printed on Windows systems.

Figure 10.1 A spectrum surrounded by a shadowed frame

10 9 8 7 6 5 4 3 2 1 0 ppm
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10.2.1 EPSI support (Unix)

Compared to bitmap formats EPSI has the advantage of being scalable, i.e. you can
rescale EPSI graphics without losing resolution.

To import an EPSI file create an EPSI object, enter the standard object editor for
this object and choose the file name. (See chapter 6.1.3 on page 60.) With XWIN-
PLOT you can print layouts with EPSI objects on any printer supported by XWIN-
PLOT. The printer need not be PostScript compatible.

A layout can be exported as an EPSI file like this:

1. Enter the Printer Setup dialog, choose EPSI as printer type and press the Apply
or the OK button. (See chapter 5.11.3 on page 54.)

2. Enter the Print dialog and press the To File button. Enter a file name for your
EPSI file and press the OK button. By convention, EPSI files end with .eps or
.epsi. 

Figure 10.2 The building blocks of the graphic in Figure 10.1

10 9 8 7 6 5 4 3 2 1 0 ppm

c)
b)

c)
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10.2.1.1 EPSI import to FrameMaker

This is how to import an EPSI file to FrameMaker:

1. From the File menu, choose Import and then File.

2. Select the file you want to import and press Import.

If you use FrameMaker 4 for Windows, please note:

• FrameMaker 4 cannot display EPSI directly and therefore uses a low-resolution
preview bitmap. On a PostScript printer, however, the EPSI file will be printed
in its full resolution.

• If you transfer the EPSI file generated by XWIN-PLOT from your workstation to
your PC using the ftp program, you must use binary mode for the transfer.

10.2.1.2 EPSI import to CorelDraw

To import an EPSI file to CorelDraw 6 you must do the following:

1. From the File menu, choose Import.

2. Select Postscript Interpreted (PS) for Files of type.

3. Select the EPSI file and click on Import.

4. In the Import PostScript dialog, click on OK.

Like XWIN-PLOT CorelDraw supports the printing of drawings with imported EPSI
files on non-PostScript printers.

10.2.2 Windows Metafile Support (Windows)

Like EPSI, WMF19) graphics are scalable without loss of quality. There are two
ways WMF graphics can be used:

1. Create a Metafile object, enter the standard object editor for this object and
choose the file name. The layout now includes the reference to an external
WMF file. Note that this file must be still present to display and print the WMF
graphics.

2. Import graphics of other Windows applications from the clipboard using Paste
from the menu Edit. The metafile data are now part of the layout file and will

19) Some files use an .EMF suffix indicating that they are in Enhanced Metafile Format. XWIN-
PLOT reads both formats WMF and EMF.
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be saved with it. In that case there is no external file containing the image.

This way the storage location of the image data can be external or internal. The
standard object editor for Metafile objects will show you this for each object with a
short description.

To export your complete layout graphics to a Windows Metafile simply choose
Export from the File menu. XWIN-PLOT will create an image in the EMF format
(Enhanced Metafile Format) that is accepted by almost all graphically oriented
Windows applications.

Of course you can copy some or all of your graphics in XWIN-PLOT to the clip-
board. If you want to copy the complete layout choose Mark All and then Copy
from the menu Edit. Then switch over to your target application and use Paste to
insert the graphics.

Text marked in XWIN-PLOT will be exported as graphics. If you want to have a text
object exported as text only, open the standard object editor for that text object,
select the Edit button, mark the text and choose Copy after pressing the right
mouse button.

10.3 Shortcuts

Some frequently needed XWIN-PLOT functions cannot only be called from the
menu bar but also by using so called shortcuts. This means that a modifier key is
pressed in addition to another key in order to call functions that are also available
in the menus of XWIN-PLOT. The shortcut [Control][A], for example, is an equiv-
alent to the menu entry Mark All. Using shortcuts instead of the mouse can save
time when working with XWIN-PLOT.

Note that shortcuts probably don‘t work with a key like Num Lock, Scroll Lock
or Caps Lock pressed.
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Notes for Windows Users

With the Windows NT / Windows 2000 version of XWIN-PLOT the graphical user
interface was adapted to the Windows look-and-feel. Additionally, the behavior of
some functions using operating system features was changed in order to improve
the embedding in the Microsoft Windows environment.

11.1 Printing and the Printer Setup

XWIN-PLOT for Windows uses the Windows printer drivers. This means that any
printer for which a driver is correctly installed under Windows can be selected as
printing device in XWIN-PLOT.

Following the Windows style guidelines the option Printer Setup is called Page
Setup and is available in the File menu. Selecting Print or Page Setup from the
File menu will show standard dialogs. The Split Page option is part of the Page
Setup dialog like it is under UNIX. 

If the user creates a new layout XWIN-PLOT uses the Document Defaults of the
currently selected default printer to determine the document size. To change the
default paper size (which will be typically Letter or A4) click on Start menu / Set-
tings / Printers, mark your current default printer and choose Document Defaults
from the File menu. The dialog will be device-dependent.
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XWIN-PLOT layout files created under Windows can be used by XWIN-PLOT under
UNIX and vice versa. However, the name of the printer device will in most cases
not be correct. Just open the Page Setup dialog to specify the correct printer name.

11.2 Support for WMF/EMF graphics

To easily integrate graphics from other Windows applications with your layouts
XWIN-PLOT provides a “Metafile” graphics object. Use “Metafile” objects like the
EPSI objects of the Unix version. XWIN-PLOT graphics can be exported to EMF
graphics files or by use of the clipboard or choose Export from the menu File to
create a graphics file in Enhanced Metafile Format. Refer to Chapter 10.2 for
detailed information.

11.3 Clipboard

XWIN-PLOT fully supports the Windows clipboard for text and graphics. If you cut
or copy one or more XWIN-PLOT objects to the clipboard you can not only paste
them to other XWIN-PLOT layouts but can also import them using the Paste com-
mand from the Edit menu in applications like WinWord or PowerPoint. It is also
possible to import text and graphics from other applications.

To view the current clipboard contents use the Clipboard Viewer by choosing Start
/ Programs / Accessories / Clipboard Viewer.

11.4 Support for Email Clients

XWIN-PLOT is able to send the current plot graphics as Email. Simply choose
Send... from the File menu. Your default mail client will popup and create a new
empty message with your plot added as a file attachment. For the attached graphics
file the EMF (Windows Metafile) format will be used to ensure highest quality. 

To enable mail support, you must have installed a Simple MAPI Client on your sys-
tem. You can use the Windows Messaging package that is provided as part of the
Windows setup. Another common client is Outlook Express that is part of
Microsoft Internet Explorer. Please note that in Outlook Express, the Simple MAPI
Client functionality must be explicitly enabled in the applications options. For
other mail programs, please refer to the related product documentation.
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11.5 Toolbar

Below the menu bar XWIN-PLOT for Windows displays an additional toolbar con-
sisting of some common icons. These provide easy access to often used file and
edit functions. Moving the mouse cursor over the toolbar gives a short explanation
for each button in the status bar.
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Appendix

12.1 Errors and warnings

12.1.1 Messages in the terminal window

Messages that appear in the terminal window (while running XWIN-PLOT usually
signal fatal conditions. On Windows they will be displayed in an extra message
window. Please submit a detailed report of such messages to Bruker.

12.1.2 Messages in dialog windows

A typical warning in XWIN-PLOT is shown in Figure 12.1. In most cases such
warnings result from NMR data files that do not exist. All NMR data needed by
the plot editor must have been created previously with XWIN-NMR as described in
Chapter 3. In practical terms this means that if integral data is to be displayed in
XWIN-PLOT, the spectrum must have been integrated in XWIN-NMR. If you want
the plot editor to show peak labels, these labels have to be created in XWIN-NMR

first. Remember that XWIN-PLOT is a program for displaying and printing NMR
data, not for creating or processing them.
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Figure 12.1 Warnings are displayed inside a dialog window
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12.2 What‘s new?

This section gives an overview of the changes in the current version of the XWIN-
PLOT software compared to previous versions. Beginning with version 2.5.1 bug
fixes are documented in the Bruker Bug Database which is accessible on the
Bruker WWW server.

12.2.1 Changes since XWIN-PLOT 3.0

• XWIN-PLOT is now available in a version for Linux.

• After installation a large number of pre-designed layouts for typical 1H / 13C
measurements can be found in the layouts directory. Backup copies of all
layouts are placed in the subdirectory backup. All layouts will be set to read
only status after installation.

• Reset actions for 1D and 2D objects have been significantly enhanced to pro-
vide more flexibility of the axis scaling. Projections of 2D objects can have
their own reset actions. It is now possible to use axis limits as defined within
XWIN-NMR. (See Chapter 7.1.3 on page 83.)

• The new xwp command can be used instead of xwinplot in XWIN-NMR to let
all 1D/2D objects use the axis limits as defined in XWIN-NMR, independantly
from the limits and reset actions specified in the layout (page 11).

• The new xwpr command can be used instead of xwinplot on the XWIN-NMR

command line. This will have XWIN-PLOT execute a Reset on all objects com-
mand after loading the layout, just as AUTOPLOT does it by default (page 11).

• When starting from within XWIN-NMR, XWIN-PLOT and AUTOPLOT will auto-
matically execute the commands xwp_lp and / or xwp_pp on the current
dataset if the parameter list and/or peak list is missing. (page 17, see also Chap-
ter 9.2 on page 92).

• AUTOPLOT always stores an archive copy of the currently used layout file in the
used dataset. (See Chapter 5.7.1 on page 50.)

• A new option for EPSI / Meta objects allows more flexibility in handling exter-
nal graphics (page 60).

• The location of external EPSI / Meta objects can now be specified relative to
the assigned data set. This allows to include different graphics files for different
data sets. EPSI / Meta objects also understand the symbol $XWINNM-
RHOME. (Refer to page 16 in chapter 2.2.4.)
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• XWIN-PLOT now tries to get a more intelligent assignment of colors to different
levels when the number of levels in the layout and the data set do not match
(Section 6.2.2).

12.2.2 Changes since XWIN-PLOT 2.6.0
• The new commands Save Layout/Portfolio to Dataset / Load Layout/Portfo-

lio from Dataset provide a way to quickly save the layout to the current data-
set. The portfolio is saved as portfolio.por in the current dataset.

• If a file portfolio.por is found in the current dataset it is loaded instead of
the default portfolio during startup of XWIN-NMR. (See chapter 5.6.2).

• EPSI and Metafile objects now have an option to always keep the original
aspect ratio if desired.

• Under Windows now two formats are provided for the export of layouts, PostS-
cript (.ps) and Enhanced Metafile (.emf).

• The new option -e enables autoplot to create PostScript / Enhanced Metafiles
instead of printer output. (See Chapter 2.2.2 on page 14.)

• An extended set of AU macros improves the handling of datasets, portfolios
and file creation in AU programming (See Chapter 9).

12.2.3 Changes since XWIN-PLOT 2.5.1

• XWIN-PLOT under Windows NT can now include “Windows Metafile” graphics
into its layouts. Pasting graphics from other Windows applications using the
windows clipboard is supported. See Chapter 10.2 for details.

• With the Windows NT version you can send your current plot graphics as Email
directly from within XWIN-PLOT (Chapter 11.4).

• Additional rescale factor for 1D objects for automation (See page 81).

12.2.4 Changes since XWIN-PLOT 2.0.1
• XWIN-PLOT is available in a version for Windows NT. See Chapter 11 on page

101 for details.

• Added dataset-related text object. (Refer to page 78.)
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12.2.5 Changes since XWIN-PLOT 2.0.0

12.2.5.1 Bug fixes

• Fixed T1/T2 curve calculation algorithms.

12.2.6 Changes since XWIN-PLOT 1.4.4

12.2.6.1 General remarks

XWIN-PLOT 2.0 is released mainly in order to be compatible with XWIN-NMR 2.0.
Note that XWIN-PLOT 2.0 is not compatible with old versions of XWIN-NMR.

12.2.6.2 New features

• The reset options for 1D and 2D NMR objects were moved to the automation
editors. (See Chapter 7 on page 81.)

• Positive and negative 2D projections defined within XWIN-NMR are automati-
cally added to the XWIN-PLOT data set selector if XWIN-PLOT is started from
within XWIN-NMR. (Chapter 3.7 on page 19.)

• The settings made in the Attributes Selector can be loaded and saved.

• Additional help is provided by toolbar hints and startup tips. (Chapter 5.11.1 on
page 52.)

• The on-line help is based on the Acrobat Reader only.

• The stand-alone versions of XWIN-PLOT and AUTOPLOT were renamed to
xwinplot and autoplot, resp.

12.2.7 Changes since XWIN-PLOT 1.4.0

• Text files can be loaded into a text object. (Refer to page 62 in chapter 6.1.4.)

• 2D projections can be scaled and scrolled using the 2D object editor. (Chapter
6.2.2 on page 75.)
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12.2.8 Changes since XWIN-PLOT 1.3.0

12.2.8.1 New features

• The main window layout was changed in order two support two major editing
modes Basic and NMR.

• A special 2D editor, which includes a level editor, was added. (See Chapter
6.2.2 on page 75.)

• A new object for displaying T1/T2-Fit curves was added. (See Chapter 6.1.11
on page 70.)

• A facility to edit a list of data directories was added to the Portfolio Editor. (See
Chapter 5.6.2 on page 47.)

• The handling of RGB colors in the Attributes Selector dialog window was sim-
plified.

12.2.8.2 Bug fixes

• EPSI objects created by particular PC programs were not always displayed cor-
rectly. This bug has been fixed.

• Printing very large 2D spectra (e.g. on A0 size paper) required huge amounts of
memory. This could cause the system to run out of swap space. This has been
fixed.

12.2.9 Changes since XWIN-PLOT 1.2.0

12.2.9.1 New features

• A new program called AUTOPLOT is supplied. With AUTOPLOT layouts can be
printed automatically without having to start XWIN-PLOT first. (See Chapter 2.)

• XWIN-PLOT and AUTOPLOT are now automatically started with the layout speci-
fied by the parameter LAYOUT if started from XWIN-NMR. The LAYOUT
parameter can be set with the XWIN-NMR edo command. (See Chapter 2.1 on
page 11.)

• White washed stacked plots are supported more directly. The stacked spectra
object editor provides a new option for setting the correct curve attributes. (See
6.1.8 on page 67.)

• The Portfolio Editor supports appending of portfolio contents.
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• New devices were added to the Printer Setup.

• A section about EPSI import and export has been added to the manual. (See
Chapter 10.2 on page 96.)

• PostScript output created by XWIN-PLOT now works with programs like Corel
Draw which have static limits for the maximum number of lines for a single
object.

12.2.9.2 Bug fixes

• The scaling of FID objects did not always work. This bug has been fixed.

• Negative offsets with stacked plots now work correctly.

12.2.10 Changes since XWIN-PLOT 1.04

12.2.10.1 New features

• The XWIN-NMR interface dialog has been added. (See  3.9 on page 20.) With this
dialog it is possible to run XWIN-NMR commands from XWIN-PLOT (not for the
stand-alone version).

• Get current data set gets the current XWIN-NMR data set. This command can
be combined with Reset and Reset + Print for fast layout printing. (See 8.1.2
on page 88.)

• Update Data from Xwin-nmr updates all data used by the plot editor from
XWIN-NMR, i.e. all changes on the data sets done in XWIN-NMR are transferred
to XWIN-PLOT. (See Chapter 3 on page 17).

• The Multi-Print dialog has been added. With this dialog a series of plots can be
created very easily. (See Chapter 8.2 on page 89.)

• The EPSI (= Encapsulated PostScript Interchange) object has been added. (See
Chapter 6.1.3 on page 60.)

• Text objects now can be adjusted not to change the font size then scaling by dis-
abling Allow automatic font resize in the edit dialog. (See Chapter 6.1.5 on
page 63.) For the title and parameter object this is the default.

• By activating Use region file on reset on a spectrum (using the edit menu) the
text file reg in the processed data directory can be used to specify spectrum
regions that will be used to determine y-scaling on a reset. (See Chapter 6.1.7
on page 66.)
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• By pressing the Alt key while expanding a 1D in expand mode (See Chapter
5.2.2 on page 39.), portions of the spectra can be blown up according to the
setup in Global Setup. (See Chapter 5.11.1 on page 52.)

• If modifier keys (Shift, Ctrl, Alt) are pressed while scaling or moving spectra,
the spectrum will not change its position. This allows for the use of a spectrum
object as a clipping window. (See Chapter 5.3.3 on page 42.)

• Pressing the right mouse button now automatically switches to mark mode,
marks the object under the cursor and shows a popup menu which contains the
most frequently used commands.

• Undo now can also undo zooming.

12.2.10.2 Bug fixes

• Titles without a newline character at the end did not work. This bug has been
fixed.

• A 2D spectrum object now can display the spectrum in a range larger then the
spectrum range, e.g. a spectrum ranging from 0 to 127 points in x and y direc-
tion can be displayed in a range of -100 to 300 points in x and y direction.

• Changing the units of 2D spectrum objects now changes the units of the projec-
tions immediately.

• Scale bounding box on a 2D with projections now works.

• Under certain circumstances, the attribute selector did contain weird values,
resulting for example in spectra being drawn with wrong line thickness or line
style. This has been fixed.

• In expand mode, integrals are scaled properly now.

12.3 Known bugs

Due to the poor scaling mechanism of the X11 font scaler, text objects do not
always have a 100% WYSIWYG look. The width of text objects on the screen
may appear different from their width on the printer. This can result in text objects
to be clipped by the printer if the option Allow automatic font resize is enabled
and the width of the text objects is made smaller. In this case the text object does
not appear to be clipped on the display but it might be clipped by the printer.
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